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1 Introduction. 
This system engineer manual is intended for engineer personnel installing and 

maintaining the software and hardware of “Power-Balance” Automated Meter Reading (AMR) 

system.   

 System maintaining requirements: the personnel should possess the knowledge of 

working with MS Windows 2000 or later operating system, ORACLE 9.2.0.1.0 or later database 

management system and Microsoft Internet Explorer 5.5 or later browser. 

 

2 Purpose of the system. 
 

“Power-Balance” AMR system is designed for obtaining reliable information on the 

amount of supplied and consumed electrical and heat energy, water and gas in the domestic 

utility sector.  

“Power-Balance” AMR system is a make-to-order product and is installed by individual 

execution. Its configuration, the structure of connection to metering devices, the set of functions 

are determined by customer’s technical specification.   

“Power-Balance” AMR system consists of the following hardware: the server of software 

and hardware complex of “Power-Balance” AMR system, “USPD-1500” Data Concentrator, 

channel forming equipment, users’ Automated Working Places.  

 

3 Technical Specification 
The software and hardware of “Power-Balance” AMR system provides:  

 Monitoring four types of energy resources in the domestic sector: electrical 

energy, heat energy, water, and gas.  

 Operating with any electronic metering devices.  

 Operating via the following communication channels: local computer networks, 

power networks of 0.4 kV voltage, wire and switched communication lines, radio-

channel, and GSM channel.  

 Interacting with unlimited quantity of Data Concentrators of “USPD-1500” type 

 Using hierarchical data structure of connecting “USPD-1500” devices and servers 

of “Power-Balance” AMR system. 

 Connecting up to 1500 metering devices to one “USPD-1500”.  

 Supporting OPC DA 2.0/1.0 and OPC HDA 1.0 protocols when interacting inside 

the system and with outside producers’ software. 

 Data archiving in ORACLE, MS SQL, ACCESS database management systems. 
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 Storage of the energy metering data in “Power-Balance” AMR system database 

for not less than three years.  

 User’s WEB-interface with the usage of “client-server” architecture and 

Microsoft.NET. mechanisms.   

 Setting up the access to one or several kinds of monitored energy resources from 

the side of users and the utilities.  

 Operating on the user’s side without additional software installation (using the 

standard Microsoft Internet Explorer browser).  

 Interacting with the payment system of domestic consumers.  

 Furnishing the consumer with summary reports on energy consumption 

individually by each metering device and reports on the balance of the supplied 

and received energy resource.   

 

4 Software and hardware of “Power-Balance” AMR system.  
4.1  Structure of software and hardware of “Power-Balance” AMR system. 

 

In “Power-Balance” AMR system via different communication channels interacting are: 

“Power-Balance” AMR system server of software and hardware complex, “USPD-1500” data 

concentrators, energy metering devices and PCs of users’ Automated Working Places (AWP).  

The “Power-Balance” AMR system structure is presented in Picture 4.1.    

“Power-Balance” AMR server. This PC has the main software of “Power-Balance” AMR 

system installed, which provides administrating the hardware of data communication, electronic 

metering devices, setting up and testing the system of remote polling the metering devices, 

automatic meters’ data collection, processing and storage and displaying the received 

information in the user-friendly way.  Beside from the specialized software, the server also has 

DBMS Oracle 9.2 and Microsoft Internet Information Service installed.   
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Picture 4.1. The hardware structure of “Power-Balance” AMR system.  

 

Users’ Automated Working Places (AWP). The software of users’ automated work 

places (AWP) is developed under Intranet technology using Client-Server architecture and 

Microsoft.NET mechanisms. User AWP does not require installing any specialized software. 

The user works with the system through the standard Microsoft Internet Explorer browser.  

 

4.2  Software structure of “Power-Balance” AMR system. 

“Power-Balance” AMR Software complex consists of the following modules and 
subsystems:  

1. Configuration subsystem. 
2. Subsystem of data collection and exchange with external systems.  
3. Data storage subsystem. 
4. Data display subsystem. 
5. Data reliability subsystem. 
6. Monitoring subsystem. 
7. Security subsystem. 

 
 

The structure chart of the software complex is shown in picture 4.2.  
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                  Picture 4.2. The structure chart of “Power-Balance” AMR software complex 

 

4.2.1 Configuration subsystem. 

 The subsystem includes: 

• The module of metering devices directory (optional supply). The module provides the 

description of metering devices according to the kind of resource (electric power, heat, 

water, gas). Metering devices description presupposes unified description of available 

parameters of metering devices, addressing them according to the exchange protocol with a 

metering device. After the metering device has been described in the directory, the new 

device support is carried out at the level of Data Concentrator and Communications Server 

(dll libraries formed under specified rules). In this case, there is no need of changing the 

program code of Communications Server and Data Concentrator. 

The module of Data Concentrator configuration. The module provides all the functions of 

Data Concentrator parametering (constant parameters reading, synchronization, time 

autocorrection, changing current date and time, setting the date and time of seasons 

switching, setting the modes of polling the metering devices) and configuration (metering 

devices configuration, Slave Data Concentrators configuration, communication channels 

configuration).  

 

4.2.2 Subsystem of data collection and exchange with external systems. 

 The subsystem includes: 
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• Communications Server. The server provides automatic parallel polling of the 

metering devices by means of Data Concentrator under the prescribed time cycle using 

various communication channels (via power network 0.4 kV, radio channel, switched wire or 

GSM channel, dedicated channel) and various switching equipment of in-house production 

and outside manufacturers. Communications Server provides Data Concentrator time 

synchronization with the system time, reading the account data, the current data and the 

event log from Data Concentrator and /or metering devices, energy resources computation 

under tariffs factors, efficiency diagnostics of the communication channels, Data 

Concentrator, metering devices. The Communications server supports the interface of direct 

access to the metering device by means of Data Concentrator from the upper level system 

(if the user has the right of access to this operation), transmitting the commands of rest-

days calendar change. The Communications Server interacts with OPC data archiving 

server via HDA interface, with OPC data transmitting server via DA interface.  

• OPC data management server. The data management server is optional in the 

system and provides the information exchange between the systems when it is necessary to 

build up a multilevel AMR system or to provide the account data transmission in “soft” real-

time mode to the dispatcher system of the utility service.  

 

4.2.3 Data storage subsystem. 

The subsystem includes: 

• Database Server. The Server provides operation of two databases: on-line account 

database filled by means of the communications server and data-archiving server; and 

system account database formed by data storage subsystem based on on-line account data 

base.  The server provides the account data storage in the on-line database for not less 

than three months, in the system database for not less than three years.  

• Data archiving server supporting OPC HDA interface. Data archiving server provides 

archiving the data of account and event log into one of the three databases: Oracle, MS 

SQL or Access. The server supports on-line account databases. The server allows to 

access the historical data from any user applications of outside manufacturers through OPC 

HDA interface. 

 

4.2.4 Data Display subsystem. 

The subsystem includes. 

• WEB-server supporting Microsoft .NET mechanisms. By means of WEB-server the user 

is given a possibility to view, analyze and control the data through WEB-interface. The 
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system is provided with user rights differentiation. Different user categories have 

different possibilities of access to the system data (see paragraph Security subsystem). 

The user is given a possibility to work with several information categories:  

 Data bases of Data Concentrator, metering devices, parameters. 

 Historical data reports (simple: metering devices readings, compound: group of 

devices readings, balances on devices, groups of devices, groups of devices 

parameters). 

 Historical data diagrams. 

 Current data reports, among them on-line control of consumption and other 

parameters (power, pressure, temperature, usage) 

 Current data diagrams. 

 Log of emergency, preventive and regular events, which can be filtered by 

characteristics: general system, of Data Concentrator, of a metering device. 

 System database configuration: creating/ editing directories, system data base 

updating and so on. 

 Metering devices parametering: changing rest-days calendar, changing tariffs 

binding to time zones. 

 Users remote disconnection (metering device remote control). 

 

4.2.5  Data Reliability subsystem. 

 The subsystem is optional and includes. 

• Module of complete downloading the account data. The complete downloading 

module provides control of account data completeness in the system database and if 

necessary, makes an additional query for the missing data via Communications Server. 

 

4.2.6 Monitoring Subsystem. 

The monitoring subsystem is meant for controlling the efficiency of AMR system and its 

individual software and hardware modules. The subsystem includes.  

• Communications Server Event Log. It provides accumulating events coming from 

AMR hardware modules (Data Concentrator, meters, and communication equipment) and 

archiving these events into data-base server.  

• System Monitoring Module (optional). The module provides controlling the efficiency 

of software modules and AMR “Power-Balance” data-base server, forming, accumulating 

and archiving the notices on non-regular situations of system software modules operation.  
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• Database server monitoring procedures (optional). The monitoring procedures 

provide processing the events and preparing them for displaying in the emergency, 

preventive and regular events log, which is formed by data display subsystem. 

 

 

4.2.7 Security subsystem. 

The Security Subsystem provides differentiating the rights of display subsystem users in 

access and/or changing the “Power-Balance” AMR system’s data. Five users categories are 

supported: 

 supervisor; 

 administrator; 

 privileged user; 

 user; 

 guest. 

The user of Supervisor type has all the rights for the system manipulation. Administrator, as 

against Supervisor, cannot control the security policy. Privileged User has the right to 

change rest-day calendar, form new compound reports and the like. Ordinary User is 

permitted all the rest of operations in the upper level system. The user of Guest type is only 

allowed to use the operations of on-line parameter control (optionally) and view certain 

reports.  

 

4.3  Server software complex of “Power-Balance” AMR system. Installation and 

setting up of the components and modules.  

 

The “Power-Balance” AMR system bundled software operates under control of MS 

Windows 2000 Professional (Service pack 4) operating system and later. The full pack of the 

bundled software uses ORACLE 9.2 as DBMS. Data storage subsystem also supports DBMS 

MS SQL or ACCESS. This instruction, when describing the process of installing the system’s 

bundled software, uses DBMS ORACLE. If there is a necessity of working with DBMS MS SQL 

and ACCESS, see the description of data archiving server operating in paragraph 4.4.4.   

The process of installing the bundled software of “Power-Balance” AMR server involves 

two stages: pre-installation and main installation.   

Pre-installation stage includes the following steps:  

1. Install DBMS ORACLE 9.2.0.1.0 to the PC with preset operating system.  

2. Create the user and the layout for AMR system.  
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3. Set the support of OPC standard – start installation file: OPC Core Components 

2.00 Redistributable 1.06.msi.  

4. Set the support of electronic keys - start installation file: Sentinel Protection Installer 

7.3.0.exe.  

Main installation stage: 

If there is a necessity of installing all the software on server, it is recommended to take 

the advantage of the installation pack from the installation disc.  

 

4.3.1 Configuration subsystem. Modules installation.  

To install the configuration subsystem modules, one should start up the installation files 

of the corresponding module of metering devices directory (optional) and Data Concentrator 

configuration module (setup_DataConfig.exe) and follow the instructions of the installation 

system. After the modules are installed on the PC, one can proceed operating with them. For 

the description of modules operation, please see paragraphs 4.4.1 and 4.4.2.    

 

4.3.2 Subsystem of data collecting and exchange with external systems. Modules 

installation.  

The standard pack of the subsystem of data collection and exchange with external 

systems contains only the communications server. To install the communications server, one 

should start up the installation file sireniya_inst.exe and follow the instructions of the installation 

system. After the communications server is installed on the PC, one can proceed operating with 

it. For the description of module operation, please see paragraph 4.4.3 of this instruction 

 

4.3.3 Data storage subsystem. Components and modules installation.  

The full pack of bundled software uses ORACLE 9.2 as DBSM. If there is a necessity of 

using DBSM MS SQL and ACCESS, one should install these systems in advance on the PC 

and create corresponding empty databases for the AMR system.    

Data-archiving server is installed simultaneously with communications server installation. 

After the data-archiving server is installed on the PC, one can proceed operating with it. For the 

description of module operation, please see paragraph 4.4.4 of this instruction. The necessary 

tables for on-line database are created after first startup of data-archiving server.   

To create specialized tables for system database, after installing and first startup of data-

archiving server one should start the installation file db_install.exe and follow the instructions of 

the installation system.  
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4.3.4 Data display subsystem. Components and modules installation.  

The standard pack of data display subsystem of “Power-Balance” AMR bundled software 

is meant for operating under DBMS ORACLE 9.2. and Microsoft Internet Information Server.  

The monitoring and security subsystems are included in the data display subsystem 

installation pack.  

To install data display subsystem of “Power-Balance” AMR bundled software, one 

should start up the installation file setup.exe and follow the instructions of the installation 

system.    

 
4.3.5 Data reliability subsystem. 

To install the module of complete downloading of account data, one should start up the 

installation file rdata_install.exe and follow the instructions of the installation system. After the 

complete downloading module is installed on the PC, one can proceed operating with it. For the 

description of module operation, please see a separate instruction.  

 

4.4  Server bundled software of “Power-Balance” AMR system. Instructions on 

working with modules.  

 

4.4.1 Working with module of metering devices directory. 

The module of metering devices directory is designed for unified description of metering 

devices parameters, which one can access for reading and recording, as in devices cyclic 

polling, so by using the interfaces of direct access to the device through communications server 

and user interface of data display subsystem. As a result of module operation, the mdb-file is 

created, which describes the parameters of all metering devices of the AMR system. During 

installation, the file of metering devices directory is named DB_METER.MDB.      

With the help of the directory described are the metering devices meant for operating 

with one of the four kinds of resource: Electricity, Heat, Water, and Gas. In the selected kind of 

resource, one should also define the device class, e.g. by the voltage type for electricity 

metering devices (0,38 kV, 10 kV), and define the device subclass, e.g. three-phase or single-

phase. After defining the device class and subclass, one can create the description for the new 

metering device. The screenshot of the working window with file directory downloaded is shown 

in picture 4.3.  

When describing a metering device’s parameter, the following fields are to be filled in. 

For the metering device:  



 

• the unique code of metering device type (see Picture 4.3. “Code” field) –is formed 

by automatic module;  

• device type name (see Picture 4.3. “Device Type” field) is set by the user when 

creating a new device description.  

 

 
                   Picture 4.3. The work window of metering devices directory. 

 

For each parameter:  

• parameter name (see Picture 4.3. “Name” field);  

• parameter length (see Picture 4.3. “Length” field); 

• parameter address (see Picture 4.3. “Address” field) – the address can change 

from 1 to 6 positions depending on the interacting protocol with the device (see 

below); 

• parameter type (see Picture 4.3. “Type” field) can be set depending on the 

parameter type – current or archival, if this is required under the interacting 

protocol with the device; 
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• parameter form (see Picture 4.3. “Form” field) can be set depending on parameter 

form – analogue or discrete,  if this is required under the interacting protocol with 

the device; 

• parameter class (see Picture 4.3. “Class” field) – main or supplementary; main 

parameters are only those that can be obtained directly from Data Concentrator 

on this metering device, all the other parameters are supplementary and can be 

obtained only through direct interaction with the metering device; 

• list of parameter groups (see Picture 4.3. “Groups” field) is a list of names of 

parameter groups. The metering device parameters can be joined into groups, 

each group is given a unique name and ID. Only those parameters can be 

grouped that can be requested in one pack under the protocol of operating with 

the device or Data Concentrator.  

The principle of describing the metering device parameters depends on the protocol 

used when accessing the device. For each device, the method of parameter addressing cab be 

described, taking onto account that the number of elements in the address is fixed for the given 

device type, and can be set when creating a new device description from 1 to 6. When 

describing a parameter with help of address, one should set the address for the parameter in 

such a way that the parameter is identified unambiguously when realizing the interacting 

protocol with the device. It is not allowed to set a variable address to the same parameter. For 

example, “Rest-days calendar” parameter can be set for a certain month and year with respect 

to the current year. Accordingly, when describing this parameter, one should state 

unambiguously what month and year this parameter is for. So, “Rest-days calendar” parameter 

will be described as “Rest-days calendar for January of current year” and so on. For the 

parameters of electricity meters GRAN-ELECTRO CC-301 and CC-101, a four-element 

address has been determined: first – parameter №, second – bias, third – tariff, forth -  

specification. In accordance with such address, “Rest-days calendar for January of current 

year” parameter will be described by the following address: 29, 0, 0, 1.   

 

4.4.2 Data Concentrator Configuration module. 

For the description of work with Data Concentrator configuration module, please see a 

separate document.   

 

4.4.3 Work with Communications server. 
Communications server (Sirenia.exe) provides automatic parallel polling of the metering 

devices by means of Data concentrator under given time cycle using different communications 



 

channels and various switching equipment of in-house production and outside manufacturers. 

After startup, the program work window is as shown in Picture 4.4. 
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                Picture 4.4. Work window of Communications server. 

 

4.4.3.1 Creating Communications server configuration. Start Data Concentrator 

polling. 

To create a new configuration, one should take the following steps: 

1.  Open Data Concentrator configuration: menu File, menu Finish reading 

configuration. 

2. Open directory database of metering devices types: menu File, menu Open 

directory. 

3. Go to Groups window, clicking the corresponding tab. 

4. Create a group for polling parameters of Total cumulative energy type. For that, 

create a new group, calling menu by clicking with mouse right key in the Group 

line and choosing Create point (see picture 4.5.1). Choose Current reading 

function. Choose All metering devices and select all parameters displayed in 

parameter window. By means of blue button arrow-up, move all parameters of 

Total cumulative energy type to the polling window. Set the needed value for 
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Polling period parameter. For each parameter, set the archiving tag. For that 

purpose, the double-click of the parameter name in the polling window will call up 

tag-navigator, with the help of which you should set the corresponding tag form 

the archiving server.       

5. Create a group for polling parameters of Cumulative energy for the beginning of 

the month type.  For that, create a new group, calling menu by clicking with 

mouse right key in the Group line and choosing Create point (see picture 4.5.1). 

Choose Indication for the beginning of the month function. Choose All metering 

devices and select all parameters displayed in parameter window.  By means of 

blue button arrow-up, move all parameters of ‘Cumulative energy for the 

beginning of the month’ type to the polling window. Set the needed value for 

Polling period parameter. For each parameter, set the archiving tag. For that 

purpose the double-click on the parameter name in the polling window will call up 

tag-navigator, with the help of which you should set the corresponding tag form 

the archiving server.  

6. Go to Channels window, clicking the corresponding tab.  

7. Choose the channel of connecting Data Concentrator with the PC. Having placed 

the mouse on channel type, press the mouse right key and choose Create in the 

appearing window. Set the chosen channel (see picture 4.5.2). 

8. Go to Data Concentrator window and set the field Channels \ Main (see Picture 

4.4) for operation with the channel, which has been set up in point 7.  
9. Set the parameters for archiving tags: in Data Concentrator or Channels tab in 

the parameter window double-click the parameter in the field Tag value. The Tag 

navigator shall appear (see Picture 4.5.3), in which you should choose the 

corresponding tag form the archiving server.  
10. Save the settings in the created configuration: menu File menu Save or Save as.  

11. Start up the polling: menu Operations menu Start.  

12. If you need to control the Communications server operation, go to Data 

Concentrator window and choose Preview menu in the Operations menu. Re-

selecting  Preview menu in the Operations menu will switch the module back to 

editing mode.  
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Picture 4.5.1. Work window of Communications server (Group window). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Picture 4.5.2. Work window of Communications server (Channels window). 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

Picture 4.5.3. Work window of Tag navigator. 

 

4.4.4 Archiving server operation 

Data archiving server (Rovalant Data Logging Server) is a module designed for archiving 

in the ORACLE database of the information collected by means of the Communications server. 

Data Logging server is designed for receiving real-time data according to the specification of 

data access 2.0 (OPC Data Access 2.0), their accumulation and logging in a relational 

database (the supported DBMS are ORACLE, MS SQL, ACCESS, see p. 4.4.4.3 table 4).  It 

also provides the clients with the access to historical data according to the specification of 

historical data access 1.0 (OPC Historical Date Access 1.0). The server is started up with 

dlsrvr.exe file. In operating mode, the server is located in the Notification area of ОS Windows 

taskbar.  When activating the module, it opens as a dialogue box (see Picture 4.6.).   

 

 

 

 

 

 

 

 

 

 

 

 

 

                       Picture 4.6. Work window of data archiving server. 
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In the server active window, the user has access to following buttons: 

- Hide – hides server’s active window; 

- Start – starts server’s operation; 

- Stop – stops server’s operation; 

- upload – upload new configuration; 

- Unload – unload configuration; 

- Change – change active configuration; 

- Setting – setting server parameters; 

- Info – information on server designer; 

- Help – calling help; 

- Exit – exit the server program. 

For module operation, you should create configuration, which describes tags 

(parameters) available for archiving and reading. To create the configuration you should start 

up data archiving OPC-server configurator (dlcnfg.exe), the work window view is shown in 

picture 4.7.   

 

 

 

 

 

 

 

 

 

 

 

 

Picture 4.7. Work window of data archiving OPC-server configurator.  

The configurator allows to quickly create and modify configuration databases for the 

Server. Configuration database is Microsoft Access (.mdb) file.  

It is not recommended to change configuration files with the help of other programs, as 

this may lead to hardly removable errors and data loss.  

During configurator first start-up, active configuration database automatically opens. If 

active configuration database is not set or error occurred during the opening, then a new empty 
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configuration database will be set. After that, you may proceed to creating or changing the 

elements (see p.4.4.4.3).    

4.4.4.1 User interface of data archiving OPC-server configurator.  

User interface contains three elements: Main menu, Toolbar and Status line.  

4.4.4.1.1 Main menu description. 

Main menu contains six submenus.  

 

Menu “File” commands. 

New Creates new configuration database. 
Open Opens the existing configuration database. 
Save Saves the open configuration database under the same name  
Save as… Saves the open configuration database under another name  
Open active Opens configuration database, which is active on this PC  
Make active Makes the current configuration database active on this PC  
Exit Shuts down the application 
 

Menu “Edit” commands  

Rename Allows renaming the selected element  
Ban Bans the elements in this configuration database  
Activate Activates the configuration 
Cut Deletes the elements and transfers them to the clipboard  
Copy Copies the elements into the clipboard  
Paste Pastes elements from the clipboard 
Delete Deletes elements 
Select all Selects all elements 
Inverse 
selection 

Changes the selection to the contrary 

 
 Menu “View” commands 

Toolbar Shows or hides the toolbar 
Status line Shows or hides the status line 
Next bar Switching to next bar. 
Previous bar Switching to previous bar. 
Go->Back Going to previous element. 
Go->Forward Going to next element. 
Go->to upper level Going one level up. 
Update Re-load data from configuration database 
Properties Displays a dialogue with the selected elements properties 
 

Menu “Paste” commands 
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New Configuration Creates a new configuration. 
New database Creates a new database. 
New archive Creates a new archive 
New folder Creates a new folder 
New tag Creates a new tag  
 
Menu “Service” commands 

Tag navigator Displays tag navigator. 
Compress 
and restore 

Allows to compress and restore the database. 

Setting Displays the dialogue with current settings. 
 

Menu “Help” commands 

Help sections Displaying Help sections 
What is this? Displaying a short description of any screen area (toolbar button, menu 

command, etc.)  
About Displaying program version, author’s rights, etc. 
 

4.4.4.1.2 Toolbar description. 

The toolbar is displayed on the top of application window below the menu line. With the 

help of the mouse, the toolbar provides quick access to many instruments used in the 

application.  

To hide or show the toolbar, select Toolbar in View menu.   

4.4.4.1.3 Status line description. 

The status line is displayed at the bottom of the application window. To show or hide the 

status line, use command Status line in View menu. 

The left part of the status line describes the actions of menu items, using cursor keys to 

move in the menu. This part similarly displays messages that describe bar buttons actions if 

pressed. If after viewing the description of bar button command you do not want to execute a 

command, you should take off the pointer from the bar button and release the mouse button.  

Right parts of the status line indicate the status of the following keyboard keys:  

Indicator Description 
CAP Caps Lock switch turned on. 
NUM Num Lock switch turned on. 
SCRL Scroll Lock switch turned on. 
 

4.4.4.2 Working with configuration database. 

4.4.4.2.1 Creating a new configuration database. 

To create a new configuration database, select Create command in File menu. To 

quickly create a new configuration database, press Create button on the toolbar.   
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4.4.4.2.2 Opening the existing configuration database. 

1. Select Open command in File menu or press Open button on the toolbar.  

2. Choose file to be opened.  

3. Press Open button.  

4.4.4.2.3 Opening active configuration database. 

To open active configuration database, choose ‘Open active’ command in File menu. 

Active configuration database is a database that is used when initializing Data Logging Server.  

On default, active configuration database opens when the application is started. If it 

could not have been opened, a new configuration database will be created.    

4.4.4.2.4 Saving the configuration database. 

To save the current configuration database select Save command in File menu. This 

command is not available if the configuration database has not been changed or already been 

saved.   

To save quickly the configuration database, press Save button on the toolbar or 

keypress shortcut Ctrl+S.   

4.4.4.2.5 Activation of the configuration database. 

To activate the current configuration database, choose ‘Make active’ command in File 

menu.  

The active configuration database is a database that is used when initializing Data 

Logging Server. One should differentiate between the active configuration database and the 

active configuration.  

4.4.4.3 Work with configuration database elements. 

The configuration database consists of elements and is structured hierarchically. All the 

elements are divided into types of configuration database elements (See Table 1). The user 

can create, change and delete the elements  

Table 1. List of types of configuration database elements. 

Element type Description 
Root element  Is always present in the configuration database and is only used for 

presentation convenience. Has no properties. Can contain several 
Configurations.  

Configuration One configuration database can contain several configurations. But only 
one configuration in the file can be active. Just the active configuration will 
be used by the server when initializing. In each Configuration there can be 
several Databases.  

Database Database element is designed for storing the parameters of connecting to 
archival database. Each Database can contain several Archives.  

Archive Archive element is meant for storing the archiving parameters, such as 
data collecting interval, data keeping interval, etc. The Archive can contain 
Folders and historical Tags.  
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Folder Folder element is meant for the possibility of creating a hierarchical 
structure of server address space. With the help of Folders one can create 
an easy-to-use and clear for the end-user structure. Folders can contain 
other Folders and historical Tags.  

Tag Tag element is meant for storing historical tags properties. Each historical 
Tag is bound to the current tag. Data archiving is made at the tag level.   

 

Each element possesses the properties that fall into two categories: general and 

complementary. General properties are identical for all element types (see Table 2). 

Complementary properties are different for each element type (see Tables 3, 4, 5, 6). You can 

display and change the properties of one or several elements with the help of ‘Properties’ 

command of ‘View’ menu (see p. 4.4.4.2.9).  

 

 

 

Table 2. General properties of configuration database elements. 

 

Property name Description 
Element name Filled in by the user. 
Full element 
name 

Filled in automatically. Consists of parent elements’ names and the 
element’s own name divided by a special separator – a dot ('.'). 

Date of change Filled in automatically. Contains the date of element last change.  
Description Filled in by the user. Must not exceed 255 symbols. Use this property to add

comments and notes.  
Banning 
parameter 

Filled in by the user. If an element is banned, then when initializing the 
server this element and all its components will be ignored. Use this property 
to quickly drop a part of the configuration database without elements 
deleting.   

 
Table 3. Complementary properties of configuration element. 

Property name Description 
Universal time 
(UTC) 

Filled in by the user. If Use universal time (UTC) flag is set, data archiving 
will be made using Greenwich time. Otherwise, local computer time of the 
server work will be used. This flag is not set on default.  

Table 4. Complementary properties of database element 
Property name Description 

Database type Filled in by the user. Can be of three values: Microsoft Access, Microsoft 
SQL Server, Oracle.  

Connection line Filled in by the user. Contains the properties of connection to archival 
database. 

Table 5. Complementary properties of archive element  
Property name Description 

Data collecting Filled in by the user. The data from current data server will come not more 
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interval  often than the given interval. By increasing the value of this property one 
can reduce the volume of the archiving data. Is set in milliseconds. Minimum
value is 10 ms, maximum is 24 hours (86400000 ms).   

Data storing 
interval 

Filled in by the user. The data will be stored in the database during this 
interval, afterwards will be deleted. Is set in days. Minimum value is 1 day, 
maximum is 3 years (1095 days).  

Archiving 
interval 
 

Filled in by the user. The server cumulates the data in the main memory. 
They will be recorded into the database when the interval expires (if there 
are no other conditions). By increasing this value, one can reduce the 
network traffic (if interacting with archival database is done through the local 
network) and DBMS load. Is set in milliseconds. Minimum value is 500 ms, 
maximum is 24 hours (86400000 ms), is not set on default.    

Archiving meter Filled in by the user. Recording into the database will be carried out when 
specified number of values is accumulated in the given archive buffer (if 
there are no other conditions). Minimum value is 100, maximum is 10000, is 
not set on default.  

 
 
 

Table 6. Complementary properties of tag element 
Property name Description 

Signal name Filled in by the user. Contains the full name of the current tag. Use the tag 
navigator for selecting.  

Units of measure Filled in by the user. Contains the lettering if the measure units.  
Type of 
insensitivity 
zone  

Filled in by the user. Can take on one of the three values: the insensitivity 
zone is not set, absolute or relative. Is used together with Value of 
insensitivity zone property.   

Value of 
insensitivity 
zone  

Filled in by the user. Is a numerical value of insensitivity zone. Used 
together with Type of insensitivity zone property.  

Upper range Filled in by the user. Maximum reliable signal value. 
Lower range Filled in by the user. Minimum reliable signal value. 
Update the range 
when started 

Filled in by the user. If this property is set, the archiving server will update 
ranges values when started.  

  

When giving a name to the element, one should bear in mind that:  

-  the length of the element’s name must be no more that 64 symbols;  

- elements’ names should not contain '.' symbol, since this is a separator in the full 

name; 

- elements’ names should not be repeated at one hierarchy level.  

4.4.4.3.1 Adding Configuration element. 

1. Select the root element.  

2. Choose New configuration command of Paste menu or press New 

configuration button on the toolbar.  
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4.4.4.3.2 Adding Database element. 

1. Select the wanted configuration.  

2. Choose New database command of Paste menu or press New database button 

on the toolbar.   

To quickly access the commands, you can use the contextual menu or the toolbar. To 

view the contextual menu, press the mouse right key at the selected element.  

4.4.4.3.3 Adding Archive element.  

1. Select the wanted database.  

2. Choose New archive command of Paste menu or press New archive button on 

the toolbar.  

To quickly access the commands, you can use the contextual menu or the toolbar. To 

view the contextual menu, press the mouse right key at the selected element. 

4.4.4.3.4 Creating tags hierarchy (adding Folder and Tag elements). 

Adding new folder: 

1. Select the wanted archive or folder.  

2. Choose New folder command of Paste menu. 

Adding new tags 

1. Select the wanted archive or folder.  

2. Choose New tag command in Paste menu to add one or several tags.  

3. If you wish to add only one tag with no connection to the current data signal, 

then answer No to the question about opening tags navigator; otherwise press 

Yes.   

4. Select the wanted tags in Tags navigator (see Help for Tags navigator)  

5. Press OK.  

When adding tags using Tag navigator, you not only create tags and folders (the 

address space structure of current data server is reproduced), but also ‘signal name’ property is 

filled in.   

To quickly access the commands, you can use the contextual menu or the toolbar. To 

view the contextual menu, press the mouse right key at the selected element.  

4.4.4.3.5 Configuration element activation.  

1. Select the wanted configuration.  

2. Choose Activate command in Edit menu or press Activate button on the toolbar.  

3. For the activated configuration the pictogram must be changed.  

In one configuration database only one configuration may be active. When activating one 

configuration, all the others automatically turn non-active.  
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To quickly access the commands, you can use the contextual menu or the toolbar. To 

view the contextual menu, press the mouse right key at the selected element. 

4.4.4.3.6 Copying and moving elements. 

1. Choose the wanted elements.  

2. Choose Copy command in Edit menu for copying and Cut command for 

moving.  

3. Select an element you want to paste the elements into.  

4. Select Paste command in Edit menu.  

To quickly access the commands, you can use the contextual menu or the toolbar. To 

view the contextual menu, press the mouse right key at the selected element. 

4.4.4.3.7 Changing element name.  

1. Choose the wanted element.  

2. Select Rename command in Edit menu.  

3. Enter the element’s new name. 

4. Press Enter. 

4.4.4.3.8 Deleting elements. 

1. Choose the wanted elements.  

2. Select Delete command in Edit menu.  

4.4.4.3.9 Changing elements’ properties.  

1. Choose the wanted elements.  

2. Choose Properties command in View menu.  

3. Set elements’ properties.   

4. Press OK. 

  

4.5 Server bundled software of “Power-Balance” AMR system. Instructions on system 

startup. Instructions on creating or changing the system configuration.  

4.5.1 Instructions on system startup. 

When the system is started, the starting order of its software modules is of great 

importance. The first to be started is always the archiving server, then communications server 

automatically starts, then one can begin working with WEB interface of data display subsystem.  

4.5.2 Instructions on creating or changing the system configuration. 

After all the system components have been installed, you must set up the system 

configuration for its operation. The order of system set up activities is the following:  

1. Create Data Concentrator configuration, where you should enter the necessary 

quantity of devices to be connected.  
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2. Create archiving server configuration, taking as a base config_hda.mdb 

configuration layout. Entered into the configuration layout are the four types of 

metering device supported by the system (1 301, 2 101, 3 DTSF22, 4 DDSF22). 

When creating a real configuration, use the data of this layout. It is obligatory to 

indicate first in the folder name the ID number of the metering device that is set in 

Data Concentrator’s configuration. For example, in the layout the first comes 301 

device (GRAN-ELECTRO CC-301), the second – 101 (GRAN-ELECTRO CC-

101) and so on. Copy from the layout the necessary folders with device type and 

rename them in accordance with the ID numbers of metering device from Data 

Concentrator’s configuration. Then delete all unnecessary folders from the 

working configuration of archiving server. Make all the necessary settings in the 

properties of Database element for connecting to ORACLE server. Make the 

configuration active.   

3. Start up the archiving server. Make sure its operation has been correct (in the line 

status – 0 lost).  

4. Start up the communications server. Create the communications server new 

configuration based on Data Concentrator configuration and directory of metering 

devices types.   

5. Start up the WEB interface of data display subsystem and create lists of metering 

devices owners, metering devices installation places, metering devices according 

to data Concentrator configuration.  

The system configuration is set for operation. The system may be started up.  

If it is necessary to make changes to system’s configuration, use the already existing 

configurations of Data Concentrator, archiving server, communications server, and enter there 

the required changes according to the above order.  
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